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Lab 1 - The HelloWorld Class
Time for lab: 40 minutes

In this lab, you will write a very simple “Hello World” Java class. 

Part 1 - Start RAD
RAD has already been installed on your computer.  We just need to configure it. 

__1. From Start menu and then select All Programs > IBM Software Delivery Platform 
>IBM Rational Application Developer 8.0 > Rational Application Developer. 

RAD will launch.

__2. You will be prompted to select a Workspace. In the workspace window, change the 
Workspace to C:\workspace

__3. Click OK.
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RAD 8.0.4 will start.

__4. If prompted by Windows firewall security unblock the program.

__5. In the Runtime environment and profile settings dialog that appears click the Cancel 
button.
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The Features with Trial Licenses dialog will open.

__6. Click Ignore.

__7. If prompted about help content select Work without Help.

__8. Close the Welcome screen.

__9. From the menu bar, select Window | Open Perspective | Other.

__10. Select Java and click OK.
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What has happened? Simple: you have changed perspective.  A perspective is a collection 
of views chosen to achieve a specific task.  We are currently looking at the Java 
perspective.

A view is simply a tiled window in the environment.  For example, you can see the 
Package Explorer view and the Outline view. 

Look at your environment and locate the following views:

The Problems view.  This should be at the bottom of the RAD environment.  Any 
coding/compile errors you make will be displayed here and (in a fit of unbridled 
pessimism) you will most likely be referring to this view quite a bit. 

The Package Explorer.  This is on the left of the IDE.

This will allow us to navigate through the Java classes we will be creating shortly.  

__11. Open the Javadoc view.  To find it, click the  Javadoc tab next to the Problems tab. 

__12. You can switch between the two views by clicking the appropriate tabs.  

__13. Similarly, locate the Declaration view. 
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The big empty space in the middle of the IDE does not look very interesting right now; 
that is because it is the Code view – and we currently do not have any code to display. 
Do not worry about it for now.

__14. Each view can be moved and resized.  Click on the Package Explorer tab and drag 
it over the area where the Problems view is. Note that the view “docks”.  Experiment 
with resizing and moving.  Don't worry about “messing up” the perspective, because we 
will reset it in a moment.

__15. From the menu bar, select Window | Reset Perspective and click OK in the box 
that appears.  All the views should “reset” to their original layouts.  Note that it is 
possible to Save a perspective that you have changed. This allows you to customize 
exactly which views you want open and how you want them laid out.  This is something 
you will probably do as you become more experienced with RAD. 

Part 2 - Create A New Java Project
Before we can create any Java code, we first need to create a Java Project.  A project in 
RAD is essentially a folder for related files. We will create a new project and then create 
our classes in that project.  Later on, if we work on a completely unrelated Java class, we 
could then create a separate, new project and create those classes in there.  This helps 
keep our code environment organized. 

__1. From the menu bar select File | New | Project...

When you do this, the New Project window will appear.

RAD can actually handle many different types of projects, depending on the code that 
needs to be developed.  In our case, we will create a simple Java project.

__2. Expand Java and then select Java Project and click Next.  

The New Java Project wizard will begin.

Here, we will describe the details of the Java project that will contain our simple 
HelloWorld Java.
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__3. Set the Project name: to be SimpleProject and click Finish.

The project will be created.  How do you know the project was created?  Simple.  Look in 
the Package Explorer view.

You should see the newly created project listed there.  Our Java code will go in this 
project.

Part 3 - Create a Java Class
Recall that in Java, all code must be contained within a Java class.  Within a class, code is 
typically placed within methods, and any class can have a main method which will serve 
as its “executable” method.  

We will now create a Java class called “HelloWorld” that will have a single main 
method, and this method will simply print out “Hello World” to the console.

__1. In the Package Explorer view, right click on SimpleProject and select New | Class

The New Java Class window will appear.
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This wizard will create a new Java class for us, and allows us to specify some options on 
the class.   When we click the Finish button on this wizard, RAD will generate a new 
Java class according to the options we specify here.  Wizards like this are one of the 
reasons that RAD is so useful; while it would have been possible to generate the class 
ourselves, RAD does it much faster. 

Most importantly, we need to give the class a name.  
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Java classes should also belong to a package, for naming convention reasons.  Think of a 
package as a name prefix.  Imagine you are working at an insurance company in a Claims 
department, and you create a class called Account.  However, imagine that another 
developer that you are working with (same company, but in the Billing division) also 
creates a class called Account.  These two classes are completely different, but have the 
same name.  How would we know which one to use?  

The answer is that each class can be placed in a package.  A package is a string of 
characters separated by periods (e.g. com.mycompany.www).  The characters can be 
anything (although typical Java naming convention usually has your company name or 
URL as a part of the package name), and it is pre-pended to the class name.  So a “fully 
qualified” class name is the name of the class preceded by its package.  

In the example above, the Billing department could be assigned a different package name 
from the Claims department; so there could be com.insuranceco.billing.Account and 
com.insuranceco.claims.Account as two separate entities. Even though the classes are 
both called Account, they belong to unique packages, thus allowing for differentiation.  

In any case, we will use the New Java Class dialog to specify a class name and package 
name for our new class.  

__2. For the Package enter com.simple and for the name, enter HelloWorld

__3. In the section  What method stubs would you like to create? make sure that the box 
for public static void main(String[] args) is checked. 
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This means that when the class is created, RAD will automatically generate the main 
method for us. 

You can ignore the rest of the options for now. 

__4. Click Finish.

RAD will now generate the Java class.  A lot has now changed in the various views. 
Firstly, the empty space that was in the center of the environment is now showing Java 
code.  This is the Code Editor view, and it is showing the results of the New Java Class 
wizard's generation.  Examine it.

Firstly, notice that the class this view is currently showing is called HelloWorld.java. 
You can tell this by looking at the name of the tab.  

This Code Editor view is editable.  You can place the cursor inside this view and type 
away; this is where you will do your coding.  However, before we examine the code, let 
us examine some of the other views. 

__5. Examine the Package Explorer view. 

The Package Explorer provides us with a high-level navigable view of each project and 
their contents.  At the moment, the only project is our SimpleProject
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Note the tree structure.  The top level is our project (SimpleProject) and immediately 
underneath that is the package com.simple   

Beneath the package is our class, HelloWorld.java.  If you double-clicked on it (or any 
other class that might be listed here), RAD would open it in the code editor window.    

If we created new packages/classes in the project, they would similarly appear here in the 
tree structure.  

__6. Examine the Outline view. 

This view presents a summary of the class that is currently open in the code editor view. 
At the moment, it is examining the HelloWorld class (as represented by the green C) that 
belongs to the com.simple package.  The outline is also showing that the class currently 
has one method: a static public method called main(String[]).  We know it is a public 
method because of the green circle next to it, and we know that the method is static 
because of the S.  (We will discuss the concept of static and public modifiers later on).

Remember that this view is just a summary of the Java class.  As we add/remove code 
from the actual Java class, this view will update accordingly. 

Turn your attention back to the code editor window. Let us examine the actual Java code 
now.  All this code has been generated for us by RAD as a convenience.  

Notice that the code is color coded. Keywords are in purple, comments are in blue and the 
remaining text is in black.  Also notice the use of curly braces '{' and '}' to denote where 
classes and methods end and begin.  

__7. Look at the first line:

package com.simple;

This the package declaration.  This should always be the first line in a Java class.  This 
line simply states that the following class belongs to the com.simple package.

__8. Examine the next line:

public class HelloWorld {

Here, we declare the class.  We are saying that this is a new class that is called 
HelloWorld and that it is public (we will discuss public modifiers later).  

12

EVALUATIO
N O

NLY



This is followed by an opening curly brace '{'.  Later, at the end of the file, this should be 
matched with a corresponding closing curly brace '}'.  Locate this closing brace now. 

Any code in between these braces will be considered belonging to this class.  This shows 
the use of braces to indicate scope.  

An unmatched curly brace pair will be flagged as an error and the code will refuse to 
compile. An important part of Java programming is learning how to properly open/close 
scope.  

__9. Examine the next few lines:

/**
 * @param args
 */

These are special JavaDoc tags.  JavaDoc is a tool that allows developers to place 
formatted comments inside a Java class.  These comments can then be pooled together to 
form a good basis for documentation.  We will not worry about this here.  You can ignore 
this for now.  

__10. Examine the next few lines:

public static void main(String[] args) {
// TODO Auto-generated method stub

}

This is a method.  The first line declares the method.   It is a public method that is static, 
and its return type is void.  It also takes one argument: an array of String objects.  This 
argument is called args.  

Remember that main is a special method.  Since this HelloWorld class has such a main 
method, it can be “run”.  When the class is run, any code inside this method will be 
executed.   Not all classes will necessarily have main methods, however. 

Again, note the use of curly braces to denote where the method begins and ends.  Just like 
the class declaration, any code that is in between these braces will be a part of this 
method.  

Currently, the body of the method only has one line and that line is a comment that was 
placed there by RAD. A comment is a piece of non-code text that is placed within code 
as a note to the person reading the code.  It can form the basis of documentation, or 
simply serve as helpful reminders as to what the code is doing for anyone reading the 
code.  Comments in Java can either be preceded with a // sequence, or surrounded by a /* 
and */ sequence. Remember that this is non-code which means the compiler will not 
attempt to process it.  

Keeping this in mind, we can see that the method currently does nothing.  Let us change 
this now. 
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__11. Using the editor, delete the line

// TODO Auto-generated method stub

__12. Replace it with the following line:

System.out.println("Hello World");

What is this line doing?  This line is invoking the println method of System.out and 
passing the string “Hello World” to it.  System.out is an object that is provided by the 
Java language itself and represents the “console” (the default location where Java outputs 
to; typically, the screen). 

println is a method that is provided for System.out and it takes one argument: a String 
object representing what needs to be printed.   (Objects will be discussed in more detail 
in class)

Pay special close attention to the brackets '(' and ')' as well as the trailing semi-colon. 
Every Java statement should end with a semi-colon. 

__13. Your code is complete.  Save your code by going to File | Save or by typing Ctrl-S

__14. Check the Problems view.  It should be empty.  

If you had made any code mistakes (e.g. typos, syntax errors, etc), an item would have 
appeared in the list.  

If any errors are there right now, go back and double check the code you typed in. 
Correct any mistakes you find. Do not proceed until there are no problems listed here.

__15. Your code is now complete.  The next step is to run it.

Part 4 - Run the Code
Now that we have completed writing the code, we can run it to see the results.  Running 
Java code implies launching an instance of the Java Virtual Machine (JVM), and then 
loading the appropriate Java class and executing its main method. Fortunately for us, 
RAD makes that simple. 

__1. Click anywhere in the code editor and select Run | Run As | Java Application from 
the menu bar.
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Troubleshooting

If you don't see the option Java Application under Run | Run As, click in the code 
editor and try again.  Alternatively, you can select HelloWorld.java in the Package 
Explorer view.  As you can see, RAD is context sensitive.

A new view (the Console view) should appear in the same area where the Problems view 
is.  Any text sent to the console (e.g. by a call to System.out.println()) will appear in this 
view.

Voila!  Our Java code has executed and Hello World has been printed. Congratulations. 
You have written and run your first Java class.

Part 5 - Change the Code
Just as an exercise, let us change the code a little. 

__1. Let us now introduce an error to see what sort of error handling features that RAD 
offers. Delete the closing " mark from the println statement and save your code. 

What happens?  
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Note that a red X has appeared in the tab title (next to “HelloWorld.java”).  This indicates 
there is an error in the class.

__2. Also note that in the left margin a similar red X has appeared on the same line that 
the error occurs on.  Finally, note that the un-closed string (“Hello World); is itself 
underlined in red. 

__3. Float the mouse cursor over the red underline. 

A little pop up appears with a description of the problem.  This is a hint to tell you what 
the corrective action should be.  Do no fix it yet though!

__4. Save the file.

__5. Locate the Problems view.  Expand Errors.

Note that the error in our code has been detected.  You may have to resize the Description 
field to see the whole text.  This view shows what resource (Java file) the error occurs in, 
and even shows the line number.  This becomes invaluable if you are working on multiple 
Java files. Finally, if you double click on the error listed doing so will open the editor on 
the exact spot where the error is.  Again, this is invaluable if you are working with 
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multiple Java files. 

__6. Finally, click on the red X in the left margin.  

__7. Two boxes pop-up.  Ignore the box in yellow; it is the box in white that is 
interesting. RAD has located the error and is actually suggesting a fix!  

__8. Double click where it says Insert missing quote

What happens?

RAD has indeed added a closing quote mark, but unfortunately in the wrong location 
(after the semi-colon, instead of before the closing bracket).  Let us see what this “fix” 
does.  

__9. Save the file.

__10. Look at the Problems view.  There are now two errors!  So while the fix suggested 
by RAD was on the right track, it ended up doing more harm than good.

__11. Fix the errors properly (by putting the quote in the right place, immediately after 
World and save the file.  Make sure all the errors are gone.

From this, you should see that the error handling features of RAD are quite thorough; 
however, you should also see that it is not perfect.  Additionally, RAD can only catch 
compile time errors (i.e. syntax errors and errors in the actual code) and not run time 
errors.  The difference should become clear to you as work through the rest of these lab 
exercises.

__12. Immediately after the existing System.out line, add another line of code as follows. 

System.out.println("Goodbye, cruel world!");

If you are not particularly conscious about using tabs, spacing, and line breaks properly in 
your code (i.e. code style), it can end up looking a little disorganized. Fortunately, RAD 
can format code for us so it looks neatly arranged.  

__13. Right click anywhere in the code editor and select  Source | Format.  

If your code was not “neatly” written, it will be miraculously re-formatted to look 
perfectly neat and organized.
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Note that in the tab for the code editor (where the file name HelloWorld.java is 
displayed) an asterisk has appeared.  This is to indicate that the file was changed, but has 
not been saved. 

__14. Save the file.  Notice that the asterisk in the code editor tab disappears, indicating 
the file has been saved.  This means the file is “current”.  There should be no errors.  It 
should look like the following. 

__15. Run the code again. (To do this, go to the menu bar and select Run | Run As | Java 
Application.)

The console window should show your new updated output.

__16. Close RAD by select File | Exit.

Don't worry about losing the state of your project; the next time you open RAD, it will 
remember what your last state was. 
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Part 6 - Review
In this lab exercise, you explored RAD and coded your first Java class. 

You saw that a Java class has a name and (usually) a package.  It has methods and its 
method/class scope is determined by braces.  You learned how to print something to the 
console by invoking the System.out.println command.

Using RAD , you created a Java project to contain the HelloWorld.java class.  You 
learned about perspectives and views, and used wizards to generate some code for you. 
Finally, you also saw some of the error-handling features of RAD.
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Lab 2 - Refining The HelloWorld Class
Time for Lab: 30 minutes

In this lab exercise, you will make a few changes to the HelloWorld class that you created 
in the last lab exercise.  Specifically, you will make it a little more interactive.  By using 
the Scanner class, you will actually prompt the user for a name which will then be 
printed back out.

By doing this, you will gain more exposure to both RAD and the Java language.  You 
should start to build a better understanding of the syntax of Java.

Part 1 - Edit the Class
Right now, our code gives out a generic “Hello World” greeting, which is a tad on the 
mundane side.  We will edit the class to print out a request for a name, and then use the 
Scanner class to extract input from the user.  A more personalized greeting will then be 
delivered to the user. 

__1. From Start menu and then select All Programs > IBM Software Delivery Platform 
>IBM Rational Application Developer 8.0 > Rational Application Developer. 

__2. Leave the same workspace and click OK.

__3. If prompted by Windows firewall security unblock the program.

__4. In the Runtime environment and profile settings dialog that appears click the Cancel 
button.

__5. The Features with Trial Licenses dialog will open. Click Ignore.

__6. If prompted about help content select Work without Help.

When RAD starts up, it should look exactly like it did when you shut it down.  RAD 
“remembers” the last state of the various views so it is easy to keep working where you 
left off.
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__7. In the HelloWorld.java class, remove the lines:

System.out.println("Hello World");
System.out.println("Goodbye, cruel world!");

__8. Then replace it with the following code:

System.out.println("Hello.  Please enter your name:");

Nothing interesting here; we are merely changing the greeting text.

__9. Immediately after that code, enter the following:

java.util.Scanner scan = new java.util.Scanner(System.in);

You will notice that as you were typing this, RAD will pop up a box underneath the 
cursor listing various class and package names; this is a convenience that RAD is trying 
to offer; specifically, it is trying to give you a code assist (i.e. guess what class/method 
you are trying to invoke, allowing you to click it instead of typing the entire thing).  This 
can be handy, but is an advanced feature; ignore those pop up boxes for now.

What is this line doing?  Well, we need to use the Scanner object, and doing so will 
require us to declare and initialize an instance of the Scanner.  This is precisely what we 
are doing here. Scanner is a class provided by Java that is in the java.util package.

The first part of the statement (java.util.Scanner scan) is the declaration and the 
second part (new java.util.Scanner(System.in)) is the initialization of the object.  

Note that the initialization uses the new keyword, which implies that we are using a 
constructor on the Scanner class.  This creates a new instance of the class.
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Also note that the reference to java.util.Scanner is a fully qualified reference, 
meaning the entire package/class name has been specified. This can be clunky, and we 
will see how to shorten this later in this lab.

Finally, notice that the constructor of the Scanner takes an argument which in this case is 
System.in.  System.in represents an 'input stream' that Java can obtain input from.  By 
default, this is the keyboard.  

So, put together, this line creates a new instance of a Scanner class, and sets it up to read 
data from the keyboard. 

__10. Immediately after that code, enter the following:

String name = scan.nextLine();

This line declares a new String variable (called name ) and assigns it to the result of a call 
to scan.nextLine().  In effect, when the user types something into the prompt and hits 
Enter, the text that is entered will be placed inside the name variable.

__11. Finally, enter the following line of code:

System.out.println("Hello, " + name);

This is similar to the usual System.out.println code we have used before, but with a twist; 
we are now using a variable inside the print argument. 

The code 

"Hello, " + name

Uses the + symbol as a concatenation tool.  Basically, it combines the string "Hello, " 
with name.  A string can be concatenated with another string, and the result is a larger 
string.  It is this larger string that is actually sent to println. 

__12. Our code is done!  Save your code.  There should be no errors. If there are, fix 
them before proceeding.

Part 2 - Run the Code
We can now execute our new, more interactive, HelloWorld class.  

__1. Run the code as you did before. (Click anywhere on the code editor and then go to 
Run | Run As | Java Application)

Examine the console view.
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This looks the same as before; our standard println commands are in use. However, what 
is different is that you can now enter text into the console.  

__2. Click anywhere on the console view and type your name, followed by the Enter key. 
The Java class will then respond with an appropriate message.

Note that the code you type is in a different color.  

__3. Run the code multiple times to make sure it works.  

Congratulations!  You have managed to add some interactivity to your simple HelloWorld 
program.

Part 3 - Import Packages
Earlier, when you entered the code to declare the Scanner object, you saw how the fully 
qualified class name was used.  This is because, by default, Java does not “know” about 
the Scanner class.  In order to locate and use it, the fully qualified package name had to 
be provided.  

If you know that the Scanner class will be used multiple times, it may be a good idea to 
import the class.  Importing a class will allow the code to use the class without having to 
fully qualify it.  Typically, a Java program will import all the appropriate classes to 
simplify coding.  We will do this now. 

__1. In the HelloWorld.java class, add the following statement immediately after the 
package statement:

import java.util.Scanner;

__2. Now, change the line where the scanner is initialized to the following:

Scanner scan = new Scanner(System.in);

Note that we no longer need the fully qualified Scanner package name because it has 
been imported.  

__3. Save the code.  There should be no problems.

__4. Run the code.  It should work the same as before.  
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Part 4 - Review
In this lab, you edited your HelloWorld class to add some interactivity.  You saw the use 
of a constructor to initialize a new class instance, and you saw how a string can be 
assigned to the result of a method call.  

You also saw how importing of packages can simplify coding. 
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Lab 3 - The Arithmetic Class
Time for Lab: 45 minutes

In this lab, you will build a slightly more complex class than the HelloWorld class; it will 
perform some basic arithmetic operations, and print out the results of the operations.

This lab is designed to give you yet more experience with the Java syntax.  Additionally, 
you will see an if statement to handle branching logic for the first time.

Part 1 - Create The Arithmetic Class
Instead of using the same HelloWorld.java class, we will create an all new class file to 
contain our code.  We will create this class in the same project (SimpleProject) and 
package (com.simple) as our existing class.

__1. In the Package Explorer, expand the SimpleProject > src > com.simple package. 

__2. Right click on the com.simple package and select New | Class.

__3. Enter SimpleArithmetic as Name.

Notice that the Package field is already populated with com.simple saving us the trouble 
of typing it in.  This is because we right-clicked on the com.simple package before 
creating this new class. 

__4. Check the box marked public static void main(String[] args). We will want RAD to 
generate this method for us. 

__5. Click Finish.

RAD will generate the class and open an editor on it.
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Part 2 - Edit the Class
Now we can begin coding the class.  It will be very simple in design; it will first prompt 
the user to enter a number, followed by a second number.  It will then display the results 
of the two numbers being added, subtracted, multiplied and divided by each other.

__1. Locate the main method and delete the // TODO comment line inside it. 

__2. Let us start by prompting the user to enter two numbers.  Enter the following code 
inside the main method.

System.out.println("Please enter two numbers:");

__3. Now, set up the Scanner class (as we did in the previous lab) with the following 
code:

Scanner scan = new Scanner(System.in);

__4. Save the file. 
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Note that RAD will complain that there are errors on this line.  What is the error?  Look 
at the Problems view.

RAD does not understand what the Scanner class is.  This is because we did not use the 
fully qualified name of the class (java.util.Scanner), nor did we import the package that 
the class belongs to.  Fortunately, we can get RAD to fix this for us automatically.  

__5. Click on the red X on the left margin of the line where the error is.   Some pop up 
boxes will appear.

__6. In the white box, double-click the line Import 'Scanner' (java.util).  

The boxes, and errors should disappear.  What happened?  Take a look at the top of the 
source file and notice that the import statement has been automatically added for us by 
RAD, thus solving our problem!  RAD is fairly good at solving these kind of import 
problems.  

__7. Save the file and all the errors should go away.

__8. We can continue coding the file.  Immediately following the scan initialization line, 
enter the following:

int x = scan.nextInt();
int y = scan.nextInt();
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These two lines are quite straightforward.  They declare int variables (x and y) and assign 
them to the result of scan.nextInt() which will retrieve input from the user.  After 
these lines are executed, x will be the first number that was entered, and y will be the 
second number that was executed. 

__9. We can now print the results of the arithmetic operations. Continue by adding the 
following code:

System.out.println("You entered " + x + " for x");
System.out.println("You entered " + y + " for y");

Here we simply print out what the values entered were.   Note the use of concatenation to 
append the ints to the output string.

__10. Continue by adding the following code. 

System.out.println("The sum of x and y is " + (x+y));

This seems like a simple concatenation, but notice the difference; we are adding an 
operation to the concatenation!  The expression (x+y) will be evaluated first since it is in 
parentheses; that evaluated sum will then be concatenated to the string and println-ed

Note that since x and y are both ints, Java understands that (x+y)  should invoke the 
addition operation.

__11. Continue with the subtraction and multiplication results.

System.out.println("The difference of x and y is " + (x-y));
System.out.println("The product of x and y is " + (x*y));

These work in the same way as before.  (Note that clever use of the copy-and-paste 
mechanism of RAD can greatly speed up typing those lines...)
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__12. Now, things become a little more complex.  We have yet to handle division but 
there is a problem. What happens if the user has entered 0 for the value of y?  Java will 
complain with a “division by 0” error.  We should prevent this from ever happening and 
we can do that by entering the following code:

if(y == 0) {
System.out.println("Cannot divide by 0.");

} else {
System.out.println("The division of x and y is " + (x / y));

}

Here, we see a traditional if-else statement.  The syntax can seem confusing at first (those 
pesky curly braces are everywhere), but is actually quite simple.  

Immediately following the if keyword is the test condition (which is in parenthesis).  In 
our case, we test to see if y is equal to 0.  (Notice that the condition uses a double equal 
sign; == is a test for equivalence; putting a single equal sign in there would imply that we 
are assigning the value of y to 0!)

Immediately after the condition, we open a curly brace and put our true clause code in. 
This is the code that will be executed if the condition evaluates to true.  In our case, we 
simply print out a message saying that division by 0 is not possible. This clause is open 
and terminated using the traditional curly braces { } 

After the true clause, we use the keyword else to begin the false clause.  The code 
contained within this set of curly braces will be executed in the event that the condition 
does not evaluate to true. In this case, if y is not equal to zero, we simply print out the 
corresponding division result.

__13. We are done.  Save the code and make sure there are no errors.

Part 3 - Run the Code
__1. Run the code as you have done so in previous labs.  

__2. Use the console and enter two positive non-zero numbers.  Make sure you get 
expected results!  (You may need to resize the console view to see all the text at once)
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__3. Try entering a zero for the second number.  Make sure the appropriate “Cannot 
divide by 0” message is displayed.

Part 4 - Break the Application
__1. Now, try entering non-numbers (like characters and punctuation marks).  What 
happens? 

A little on the ugly side.  Java has encountered a problem and is throwing an exception. 
Because the scan was expecting an int, entering character data instead has caused the 
scan object to complain.  The text in red is an exception – which is simply Java's way of 
telling you that something has gone wrong.  Exceptions will be discussed in more detail 
later on. 

This has happened because our code does not check for all error conditions – such as 
entering character data instead of numeric data.  Currently, our code does check for one 
error condition: division by zero.  

Knowing this, you could go back to the code and write if statements to check to see if x 
and y are indeed numeric values; doing so would be good error handling practice. 
Roughly sketch out (but do not code) what the if statements might look like if you were, 
in fact handling these types of errors. 
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Part 5 - Review
In this exercise, you wrote another Java class and saw more detail of how to use Java 
statements, including arithmetic operations.  You also saw how RAD can assist with 
importing of appropriate packages. Finally, you saw how to use an if statement to control 
logical flow in Java code.
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	Lab 1 -  The HelloWorld Class
	Part 1 -  Start RAD
	__1.  From Start menu and then select All Programs > IBM Software Delivery Platform >IBM Rational Application Developer 8.0 > Rational Application Developer. 
	__2.  You will be prompted to select a Workspace. In the workspace window, change the Workspace to C:\workspace
	__3.  Click OK.
	__4.  If prompted by Windows firewall security unblock the program.
	__5.  In the Runtime environment and profile settings dialog that appears click the Cancel button.
	__6.  Click Ignore.
	__7.  If prompted about help content select Work without Help.
	__8.  Close the Welcome screen.
	__9.  From the menu bar, select Window | Open Perspective | Other.
	__10.  Select Java and click OK.
	__11.  Open the Javadoc view.  To find it, click the  Javadoc tab next to the Problems tab.  
	__12.  You can switch between the two views by clicking the appropriate tabs.  
	__13.  Similarly, locate the Declaration view. 
	__14.  Each view can be moved and resized.  Click on the Package Explorer tab and drag it over the area where the Problems view is. Note that the view “docks”.  Experiment with resizing and moving.  Don't worry about “messing up” the perspective, because we will reset it in a moment.
	__15.  From the menu bar, select Window | Reset Perspective and click OK in the box that appears.  All the views should “reset” to their original layouts.  Note that it is possible to Save a perspective that you have changed. This allows you to customize exactly which views you want open and how you want them laid out.  This is something you will probably do as you become more experienced with RAD. 

	Part 2 -  Create A New Java Project
	__1.  From the menu bar select File | New | Project...
	__2.  Expand Java and then select Java Project and click Next.  
	__3.  Set the Project name: to be SimpleProject and click Finish.

	Part 3 -  Create a Java Class
	__1.  In the Package Explorer view, right click on SimpleProject and select New | Class
	__2.  For the Package enter com.simple and for the name, enter HelloWorld
	__3.  In the section  What method stubs would you like to create? make sure that the box for public static void main(String[] args) is checked. 
	__4.  Click Finish.
	__5.  Examine the Package Explorer view. 
	__6.  Examine the Outline view. 
	__7.  Look at the first line:
	This the package declaration.  This should always be the first line in a Java class.  This line simply states that the following class belongs to the com.simple package.
	__8.  Examine the next line:
	Here, we declare the class.  We are saying that this is a new class that is called HelloWorld and that it is public (we will discuss public modifiers later).  
	This is followed by an opening curly brace '{'.  Later, at the end of the file, this should be matched with a corresponding closing curly brace '}'.  Locate this closing brace now. 
	Any code in between these braces will be considered belonging to this class.  This shows the use of braces to indicate scope.  
	An unmatched curly brace pair will be flagged as an error and the code will refuse to compile. An important part of Java programming is learning how to properly open/close scope.  
	__9.  Examine the next few lines:
	These are special JavaDoc tags.  JavaDoc is a tool that allows developers to place formatted comments inside a Java class.  These comments can then be pooled together to form a good basis for documentation.  We will not worry about this here.  You can ignore this for now.  
	__10.  Examine the next few lines:
	__11.  Using the editor, delete the line
	__12.  Replace it with the following line:
	__13.  Your code is complete.  Save your code by going to File | Save or by typing Ctrl-S
	__14.  Check the Problems view.  It should be empty.  
	__15.  Your code is now complete.  The next step is to run it.

	Part 4 -  Run the Code
	__1.  Click anywhere in the code editor and select Run | Run As | Java Application from the menu bar.

	Part 5 -  Change the Code
	__1.  Let us now introduce an error to see what sort of error handling features that RAD offers. Delete the closing " mark from the println statement and save your code. 
	__2.  Also note that in the left margin a similar red X has appeared on the same line that the error occurs on.  Finally, note that the un-closed string (“Hello World); is itself underlined in red. 
	__3.  Float the mouse cursor over the red underline. 
	__4.  Save the file.
	__5.  Locate the Problems view.  Expand Errors.
	__6.  Finally, click on the red X in the left margin.  
	__7.  Two boxes pop-up.  Ignore the box in yellow; it is the box in white that is interesting. RAD has located the error and is actually suggesting a fix!  
	__8.  Double click where it says Insert missing quote
	__9.  Save the file.
	__10.  Look at the Problems view.  There are now two errors!  So while the fix suggested by RAD was on the right track, it ended up doing more harm than good.
	__11.  Fix the errors properly (by putting the quote in the right place, immediately after World and save the file.  Make sure all the errors are gone.
	__12.  Immediately after the existing System.out line, add another line of code as follows. 
	__13.  Right click anywhere in the code editor and select  Source | Format.  
	__14.  Save the file.  Notice that the asterisk in the code editor tab disappears, indicating the file has been saved.  This means the file is “current”.  There should be no errors.  It should look like the following. 
	__15.  Run the code again. (To do this, go to the menu bar and select Run | Run As | Java Application.)
	__16.  Close RAD by select File | Exit.

	Part 6 -  Review

	Lab 2 -  Refining The HelloWorld Class
	Part 1 -  Edit the Class
	__1.  From Start menu and then select All Programs > IBM Software Delivery Platform >IBM Rational Application Developer 8.0 > Rational Application Developer. 
	__2.  Leave the same workspace and click OK.
	__3.  If prompted by Windows firewall security unblock the program.
	__4.  In the Runtime environment and profile settings dialog that appears click the Cancel button.
	__5.  The Features with Trial Licenses dialog will open. Click Ignore.
	__6.  If prompted about help content select Work without Help.
	__7.  In the HelloWorld.java class, remove the lines:
	__8.  Then replace it with the following code:
	Nothing interesting here; we are merely changing the greeting text.
	__9.  Immediately after that code, enter the following:
	__10.  Immediately after that code, enter the following:
	__11.  Finally, enter the following line of code:
	__12.  Our code is done!  Save your code.  There should be no errors. If there are, fix them before proceeding.

	Part 2 -  Run the Code
	__1.  Run the code as you did before. (Click anywhere on the code editor and then go to Run | Run As | Java Application)
	__2.  Click anywhere on the console view and type your name, followed by the Enter key. The Java class will then respond with an appropriate message.
	__3.  Run the code multiple times to make sure it works.  

	Part 3 -  Import Packages
	__1.  In the HelloWorld.java class, add the following statement immediately after the package statement:
	__2.  Now, change the line where the scanner is initialized to the following:
	__3.  Save the code.  There should be no problems.
	__4.  Run the code.  It should work the same as before.  

	Part 4 -  Review

	Lab 3 -  The Arithmetic Class
	Time for Lab: 45 minutes
	Part 1 -  Create The Arithmetic Class
	__1.  In the Package Explorer, expand the SimpleProject > src > com.simple package. 
	__2.  Right click on the com.simple package and select New | Class.
	__3.  Enter SimpleArithmetic as Name.
	__4.  Check the box marked public static void main(String[] args). We will want RAD to generate this method for us. 
	__5.  Click Finish.

	Part 2 -  Edit the Class
	__1.  Locate the main method and delete the // TODO comment line inside it. 
	__2.  Let us start by prompting the user to enter two numbers.  Enter the following code inside the main method.
	__3.  Now, set up the Scanner class (as we did in the previous lab) with the following code:
	__4.  Save the file. 
	__5.  Click on the red X on the left margin of the line where the error is.   Some pop up boxes will appear.
	__6.  In the white box, double-click the line Import 'Scanner' (java.util).  
	__7.  Save the file and all the errors should go away.
	__8.  We can continue coding the file.  Immediately following the scan initialization line, enter the following:
	__9.  We can now print the results of the arithmetic operations. Continue by adding the following code:
	__10.  Continue by adding the following code. 
	__11.  Continue with the subtraction and multiplication results.
	__12.  Now, things become a little more complex.  We have yet to handle division but there is a problem. What happens if the user has entered 0 for the value of y?  Java will complain with a “division by 0” error.  We should prevent this from ever happening and we can do that by entering the following code:
	__13.  We are done.  Save the code and make sure there are no errors.

	Part 3 -  Run the Code
	__1.  Run the code as you have done so in previous labs.  
	__2.  Use the console and enter two positive non-zero numbers.  Make sure you get expected results!  (You may need to resize the console view to see all the text at once)
	__3.  Try entering a zero for the second number.  Make sure the appropriate “Cannot divide by 0” message is displayed.

	Part 4 -  Break the Application
	__1.  Now, try entering non-numbers (like characters and punctuation marks).  What happens? 

	Part 5 -  Review

	Lab 4 -  Project - Prompt and Store StockAccount Information
	Part 1 -  Start RAD and Create Project
	__1.  If it is not already running, start RAD.  Use the same workspace as you are using for other labs to simplify things.
	__2.  Be sure you are in the Java perspective.  If needed, you can select Window -> Open Perspective -> Other....  Then, select Java (default) and click OK.
	__3.  From the menu bar select File -> New -> Project...
	__4.  Expand Java, select Java Project and click Next.
	__5.  Fill in a project name.  You can use any project name you want as long as it is different than existing projects.  You can call the project “StockProject” if you want but this is only a suggested project name.
	__6.  Press the Finish button to create the project.

	Part 2 -  Create the StockTracker Class
	__1.  In the Package Explorer view, right click on your project and select New -> Class.
	__2.  Enter com.stock for the package.
	__3.  Enter StockTracker for the name of the class.
	__4.  Check off the box for creating a “main” method as this will be required to run the program.
	__5.  Press the Finish button to create the class.

	Part 3 -  General Requirements
	Part 4 -  Sample Output
	Part 5 -  Importing Solutions
	__1.  Delete any project called 'StockProjectSolution'.
	__2.  From the File menu, select File -> Import
	__3.  From the list of import sources, expand the General folder and select Existing Projects into Workspace
	__4.  Press the Next button.
	__5.  Select the Select archive file option.
	__6.  Press the Browse button and find the Zip file for the solution you want to import. This should be 'C:\LabFiles\Solutions\Lab 04-StockProject.zip' and click Open.  Ask your instructor about the location if you can't find it. 
	__7.  Check off the checkbox next to the project you want to import.
	__8.  Press the Finish button to import the project.
	__9.  Expand StockProjectSolution > src > com.stock
	__10.  Right click on StockTracker.java and select Run As > Java Application.
	__11.  The Console will show the program running. Enter your name and a balance.


	Lab 5 -  Creating A Simple Object
	Part 1 -  Create A New Project
	__1.  From the menu bar, go to File | New | Java Project.
	__2.  The New Java Project wizard will appear. For the Project name, enter BankAccountProject and click Finish.

	Part 2 -  Create the BankAccount Class
	__1.  Right click on BankAccountProject in the Package Explorer and select New | Class.
	__2.  For the Name, enter BankAccount
	__3.  We will create a new package.  For the Package, enter com.simple.account
	__4.  This class will not have a main method as it is strictly an domain object class, so make sure the box for public static void main(String [] args) is left unchecked. 
	__5.  Click Finish.
	__6.  To close them, click on the appropriate tab and click the X button on the tab.  If you need to open them later on, navigate to them through the Package Explorer and double click on them to re-open them in the editor.
	__7.  Add the following field declarations, after the opening '{', following the class declaration.
	__8.  Save your code.  There should be no errors. It should look like this:
	__9.  We have now created a simple Java class that has fields.  Expand the BankAccount class at the Outline view.
	__10.  Try clicking on one of the fields in the Outline view.  What happens in the code editor view? 
	__11.  Enter the following code after the field declarations.
	__12.  Save the code.  There should be no errors.  Your code should look like the following:
	__13.  Examine the Outline view.  Notice that the method has been added to it.  What happens when you click on it? 

	Part 3 -  Create the Tester Class
	__1.  Create a new class by right clicking on BankAccountProject and select New | Class.  
	__2.  Set the Package to be com.simple.test and set the Name to be BankAccountTester
	__3.  Make sure the box for public static void main(String [] args) is checked.
	__4.  Click Finish.
	__5.  Remove the usual comment from the main method.
	__6.  Now, let us begin coding.  In the main method, add the following code:
	__7.  An easy way to do this is to click anywhere on the code editor and type 
	__8.  Save the file.  There should be no errors.
	__9.  Immediately following the instantiation code, add the following statement:
	__10.  Set the state of the other two fields by adding the following two lines.
	__11.  Add the following code immediately after the setting of the balance.
	__12.  Save the code.
	__13.  Run this code as a Java Application by selecting from the menu, Run >  Run As > Java Application.
	__14.  Now, let us try invoking an operation on the class.  Recall that we have written one method: the deposit method.  We will use it now.  Immediately before the first println statements, insert the following:
	__15.  Save the file. 
	__16.  Test this by running the class.

	Part 4 -  Review

	Lab 6 -  Project - Create a StockAccount Class
	Part 1 -  General Requirements
	Part 2 -  Sample Output
	Part 3 -  Discussion Questions

	Lab 7 -  Getters and Setters
	Time for Lab: 30 minutes
	Part 1 -  Problems of Direct Method Access
	__1.  Open the BankAccount.java class.
	__2.  Change the modifiers to private as shown below.
	__3.  Save the file.  There should be no errors in the BankAccount class. However, if you look at the Problems view, something has appeared. 
	__4.  Our next step is to begin coding the accessor methods.  Add the following method, after the closing curly brace } of the deposit method.
	__5.  Save the file. 
	__6.  Switch back to BankAccountTester.java.  There should be six errors on the class. Locate the line: 
	__7.  Then change it to:
	__8.  Now, let us write the corresponding get method. Switch back to BankAccount.java and add the following method, after the previous set method:
	__9.  Save the file.
	__10.  We have now written a get method.  We should change our BankAccountTester class to use it.  Switch back to the BankAccountTester class and locate the line:
	__11.  Change it to the following:
	__12.  Save the file.  
	__13.  Switch back to BankAccount.java and add the following two methods to the class:
	__14.  Save the file.  
	__15.  Switch back to BankAccountTester.  We will change it to use the new get and set methods.  
	__16.  Locate the line: 
	__17.  Change it to:
	__18.  Now, locate the line:
	__19.  Change it to:
	__20.  Save the file.  Two more errors should go away. 

	Part 2 -  Generating Accessors
	__1.  Switch back to BankAccount.java, and examine the Outline view. 
	__2.  Right click on balance: float here in the Outline view. Then select Source | Generate Getters and Setters.
	__3.  Notice that it has located our balance field and is preparing to generate the get and set methods for it.  Click OK.
	__4.  Save the file.  There should be no errors.  
	__5.  Switch back to the BankAccountTester.java and change the code to use the new getter and setter methods for the balance.
	When you are finished, the code should look like this: 
	__6.  Save the file.  All the errors should be gone.  
	__7.  Run BankAccountTester.  It should look the same as before.  

	Part 3 -  Accessor Error Handling 
	__1.  Open BankAccount.java.   
	__2.  Change the code for the setBalance(float balance) method to the following:
	__3.  Save the file.  There should be no error. 
	__4.  Switch back to the BankAccountTester.java.  
	__5.  Let's test this.  Change the setBalance() amount to be -100f and save.
	__6.  Now run the code.  What do you see?
	__7.  Change the value of the setBalance back to the original amount (100f) and save the file.
	__8.  Run the code again. It should show again 150 as Balance.

	Part 4 -  Review

	Lab 8 -  Project - Improve Encapsulation
	Part 1 -  General Requirements
	Part 2 -  Sample Output
	Part 3 -  Extract Methods
	__1.  In your StockTracker code select the lines of code that print out the introduction to the program.  Make sure you select the entire block of statements and not any partial statements or you will not see the options shown next.
	__2.  With the code above selected choose the Refactor → Extract Method... menu option.
	__3.  In the dialog that appears, change the name of the new method to 'printIntro' as shown below and click the OK button.
	__4.  You should see a new private method added that encapsulates the selected code that had been in the 'main' method.  The code in the 'main' method was replaced with a call to this method.
	__5.  In your StockTracker code select the lines of code that print out the details of the account.  Again make sure to select complete statements.
	__6.  With the code above selected choose the Refactor → Extract Method... menu option.
	__7.  Change the name of the new method to 'printAccountSummary'.  Notice there will also be a method parameter because the method will need to have access to the account to print the summary.
	__8.  Press the Preview> button.
	__9.  Look at the summary of changes to be made and press the OK button.
	__10.  Notice the 'main' method has been rewritten to call the new method for printing the account summary and pass in the account object as the parameter to the method.  This method is now something we can use anytime you want to print out the basic info for the account.
	__11.  In the 'main' method, select ALL of the code between the calls to the 'printIntro' and 'printAccountInfo' methods.  The code you have to prompt for the account info may be slightly different but you should still select all of the code between the calls to the other two methods.
	__12.  With the code above selected choose the Refactor → Extract Method... menu option.
	__13.  Change the name of the new method to 'collectAccountInfo'.  Notice that there should not be any parameters but the method should return a StockAccount object.  If your method to be created doesn't have this signature contact your instructor as you may need to move code around in the 'main' method before extracting the new method.
	__14.  Click the OK button to create the new method and replace the code in the 'main' method with a call to it.  Notice how much simpler the code in the 'main' method is.
	__15.  Save all files and make sure there are no compilation errors.  The goal of refactoring is to modify the structure of the code without introducing errors.

	Part 4 -  Discussion Questions

	Lab 9 -  Using Constructors
	Part 1 -  Creating Another Instance Of The BankAccount
	__1.  Open BankAccountTester.java.  
	__2.  Add the following code inside the main method, after the println statements.
	__3.  Now, set some data on that instance.
	__4.  Immediately following this, create yet another instance of the account, and set its data as follows:
	__5.  Save the code. There should be no errors.

	Part 2 -  Create The New Constructor
	__1.  Open the BankAccount.java class.  
	__2.  Add the following method right after the field declarations.
	__3.  Save the code.  There should be no errors on the BankAccount class.  However, examining the Problems view shows something:.
	__4.  Delete the following code:
	__5.  Replace it with the much simpler:
	__6.  Use this constructor elsewhere in the code.  Delete this code:
	__7.  Replace it with:
	__8.  Finally, delete this code: 
	__9.  Replace it with this code: 
	__10.  Save the file. Your code has now been greatly streamlined.  It should look like the following:
	
	__11.  Run the code.  It shouldn't look any different, but it is definitely cleaner in terms of style.
	__12.  If you look in the Problems view, you will see there are some warnings.

	Part 3 -  Object Instances
	__1.  Go back to the BankAccountTester.java class and add some println statements following the construction of account2 and account3, like the following:
	__2.  Save the file and run the code.  

	Part 4 -  Static Fields
	__1.  Open the BankAccount.java class.  
	__2.  Add a new field after the other field declarations as follows:
	__3.  Generate accessors for this class as you did in the previous lab. (This was done by right clicking on the new interestRate field in the outline window and selecting Source | Generate Getters and Setters and clicking OK in the Generate Getters and Setters window.
	__4.  Save the file. There should be no errors.
	__5.  Go back to the BankAccountTester.java.  
	__6.  Let's try out these fields. We will set the field on account2.  Locate the following line:
	__7.  Immediately after, insert the following line:
	We are simply setting the field value on the instance account2.
	__8.  Now, at the end of the method, after the println of account3's balance, add the following 2 lines of code. 
	__9.  You may want to format the source code after typing these lines.  See Lab 1 if you do not remember how to do this.
	__10.  Save the file and run the class. 
	__11.  In BankAccount.java, locate the field definition for interestRate and change it to the following:
	__12.  Also change the setInterestRate method and change it as follows:
	__13.  Save the class.
	__14.  Now, let us test this.  Go back to the BankAccountTester.java class and run the code again.  What do you see?

	Part 5 -  Review

	Lab 10 -  Project - Add Constructors
	Part 1 -  General Requirements
	Part 2 -  Sample Output
	Part 3 -  Tips
	Part 4 -  Discussion Questions

	Lab 11 -  Project – Create a Stock Class
	Part 1 -  Design Discussion
	Part 2 -  General Requirements
	Part 3 -  Sample Output
	Part 4 -  Discussion Questions

	Lab 12 -  Project – Buy Stock
	Part 1 -  General Requirements
	Part 2 -  Sample Output
	Part 3 -  Tips
	Part 4 -  Discussion Questions

	Lab 13 -  Project – Sell Stock
	Part 1 -  General Requirements
	Part 2 -  Sample Output
	Part 3 -  Tips
	Part 4 -  Discussion Questions

	Lab 14 -  Looping 
	Part 1 -  Create the Class
	__1.  Close all open files. (Ctrl+Shift+W)
	__2.  In the Package Explorer, right click on SimpleProject and select New | Class.
	__3.  For the Package, enter com.simple
	__4.  For the Name, enter SimpleAdder 
	__5.  Check the box marked public static void main(String args[]).
	__6.  Click Finish.
	__7.  We will now start coding.  Enter the following code in the main method:
	__8.  Save the class.
	__9.  Examine the Problems view.  RAD will not being able to resolve  Scanner as a type. Click anywhere in the source window and hit Ctrl-Shift-O to organize imports and make the error go away.  Select java.util.Scanner when prompted and click Finish.
	__10.  Save the file.  There should be no errors.  Your code should now look like this:
	__11.  Add the following code into the body of the for loop.
	__12.  Save the code.  There should be no errors regarding to the SimpleAdder class. 
	__13.  We can now run and test the code by  right clicking on the code editor and selecting Run As | Java Application.
	__14.  Enter a number.
	__15.  Keep entering numbers until the program completes.
	__16.  Try running the program again, but entering some non-numeric (e.g. some character data) into the program.

	Part 2 -  Break and Continue
	__1.  Within the loop, right before the line:
	__2.  Enter the following:
	__3.  Save the code.  There should be no errors.
	__4.  Test the code by running the program.  Enter 10 for the first number, and -1 for all the remaining others.  
	__5.  Insert the following code immediately before the line   sum += input;  and right after the last if statement:
	__6.  Save the code.  There should be no errors.  It should look like this:
	__7.  Run the code.  Enter two integers, a few negative numbers and then 0.  
	__8.  Close all open files.

	Part 3 -  Review

	Lab 15 -  Project - Loop Until Quit
	Part 1 -  General Requirements
	Part 2 -  Sample Output
	Part 3 -  Tips
	Part 4 -  Discussion Questions

	Lab 16 -  Subclasses
	Part 1 -  Create the SavingsAccount Class
	__1.  In the Package Explorer view, expand the com.simple.account package under BankAccountProject > src.
	__2.  Right click on BankAccount.java and select New | Class.
	__3.  For the Name, enter SavingsAccount
	__4.  For the Superclass, enter com.simple.account.BankAccount.  You can also use the Browse button and type a few letters in the filter to find the correct superclass.
	__5.  Make sure the box for public static void main(String [] args) is unchecked.  We will not need a main method here.  We will test this class using our BankAccountTester. 
	__6.  Click Finish.
	__7.  Notice that right away, there is a problem.  
	__8.  Right click anywhere in the source and select Source | Generate Constructors from Superclass.
	__9.  Click OK.
	__10.  A new method appears in the source code.
	__11.  Save the file.  There should be no errors.

	Part 2 -  Test the New Subclass
	__1.  Open BankAccountTester.java.  
	__2.  Add the following code at the end of the main method.
	__3.  Save the code.  A problem appears.
	__4.  Change the import statement (the second line of code) to read:
	__5.  Save the class and the errors should disappear. 
	__6.  Continue coding.  Add the following code after the instantiation of the SavingsAccount. 
	__7.  Save the file and run the code. 

	Part 3 -  Adding A Method
	__1.  Open SavingsAccount.java
	__2.  Before the closing curly brace } for the class, add the following method:
	__3.  Save the class.  There should be no errors. 

	Part 4 -  Adding A Field
	__1.  Open SavingsAccount.java.  
	__2.  Add the following field declaration, right after the class declaration, before the constructor:
	__3.  Change the payInterest() method to check the minimum balance before updating the balance, as follows:
	__4.  Save the file.  There should no errors.
	__5.  In this Outline view, right click on SavingsAccount and select Open Type Hierarchy.
	__6.  In this Hierarchy view, click on BankAccount.
	__7.  Close the Hierarchy view.  We will not be needing it.

	Part 5 -  Test the Code
	__1.  Go back to the BankAccountTester.java class and add the following code to the main method, immediately after the println showing the sAccount's balance.
	__2.  Save and run the code. 
	__3.  Now, let us try setting the balance below the minimum.  Locate the line where the constructor is called for the SavingsAccount and change it to: 
	__4.  Save and run the code. 
	__5.  Add the following code to the main method:
	__6.  Save the file.  Notice there is a problem.  
	__7.  Delete the line you just entered.  
	__8.  Save the file.  There should no errors.
	__9.  Close all open files.

	Part 6 -  Review

	Lab 17 -  Project - Dividend Stocks
	Part 1 -  General Requirements
	Part 2 -  Sample Output
	Part 3 -  Tips
	Part 4 -  Discussion Questions

	Lab 18 -  Arrays
	Part 1 -  Object Arrays
	__1.  In the Package Explorer, right click on BankAccountProject and select New | Class.
	__2.  In the New Java Class window, enter com.simple.test for the Package. 
	__3.  Enter ArrayTester for the Name.  
	__4.  Check the box marked public static void main(String[] args).  
	__5.  Click Finish.
	__6.  Add the following code to the main method.
	__7.  Hit Ctrl-Shift-O to organize imports.
	__8.  Save the file. There should be no errors. 
	__9.  Continue by adding the following code:
	__10.  Add the following two lines of code:
	__11.  Save and run the code.  There should be no errors – but no output either.  That is fine for now.  
	__12.  Now, let us try something else.  Add the following line of code:
	__13.  Save and run the code.  What happens?
	__14.  Delete the offending line of code.  The code should now look like this:
	__15.  Add the following code: 
	__16.  Save and run the code. As expected:
	__17.  Now add the following code:
	__18.  Save and run the code.
	__19.  Finally, let us try something different.  Add the following code:
	__20.  Save and run the code. What happens?
	__21.  Remove the two lines of code added above ('fourth' variable) that introduced the errors.

	Part 2 -  Use Subclass in Array
	__1.  Modify the code of the first object to be created and stored in the array to be a SavingsAccount object instead of a BankAccount object as shown below.  You will have errors until the next steps.
	__2.  Hit Ctrl-Shift-O to organize imports and save the file. There should be no errors. 
	__3.  Run the ArrayTester class and notice the output is the same as before.
	__4.  Add the following line of code in bold: 
	__5.  Save the code and notice it doesn't compile.  This is because the 'payInterest' method is only defined in the SavingsAccount class.  Even though the object is actually a SavingsAccount object, the 'first' variable and the element of the array that refer to the object only can be sure that the object is a BankAccount.
	__6.  Delete the line with the 'payInterest' method so the code again compiles.
	__7.  Save.

	Part 3 -  Add An Array To The SimpleAdder
	__1.  Open the SimpleAdder.java code that you wrote in a previous lab under SimpleProject.  
	__2.  In the SimpleAdder.java main method, locate the following line:
	__3.  Immediately after this line, add the following code:
	__4.  Inside the loop body, locate the line:
	__5.  Immediately after this line, add the following code:
	__6.  Locate the line:
	__7.  And enter the following code immediately before it:
	__8.  Save the code.  There should be no errors. 
	__9.  Run the code.
	__10.  Close all open files.

	Part 4 -  Review

	Lab 19 -  Method Overriding
	Part 1 -  Adding A print Method
	__1.  Open the BankAccountTester.java class.  
	__2.  Open BankAccount.java.  
	__3.  Add the following method to the class.
	__4.  Save the class.
	__5.  Open BankAccountTester.java.  
	__6.  Right now, it is a mess of mostly println statements.  Let us start clean.  Delete all the code inside the main method except for all the constructor calls.  When you are done, it should look like this:
	__7.  Let us now test our new print method.  Add the following code to the main method after the constructor calls:
	__8.  Save and run the code.
	__9.  Let us see if the print statement works on our SavingsAccount.  Add the following code:
	__10.  Save and run the code.

	Part 2 -  Printing the SavingsAccount
	__1.  Open SavingsAccount.java.
	__2.  Add the following method to the class:
	__3.  Save the code.  There should be no errors. 
	__4.  Switch back to the BankAccountTester.  Without changing any code, run the class.  
	__5.  Go back to SavingsAccount.java.  
	__6.  In the print method, add the following bolded line: 
	__7.  Save the class.
	__8.  Switch back to and then run the BankAccountTester.

	Part 3 -  Using System.out.println
	__1.  Open BankAccountTester.java.  
	__2.  Add the following line of code at the end main method.
	__3.  Save and run the code.  What do you see?
	__4.  Open BankAccount.java.  
	__5.  Right click anywhere on the code editor and select Source | Override/Implement Methods...
	__6.  Check the box for toString() and click OK. 
	__7.  Delete the code inside this method, and change it to the following:
	__8.  Save the code.  There should be  no errors.
	__9.  Let us test the code.  Switch back to BankAccountTester.  
	__10.  Delete all the calls to print(), but leave the System.out.println() line.  
	__11.  Then, add the following lines:
	__12.  Save and run the code. What do you see?
	__13.  Add the following line to the main method of the BankAccountTester class.  
	__14.  Save and run the class.

	Part 4 -  Override toString In The SavingsAccount
	__1.  Open SavingsAccount.java.  
	__2.  Right click anywhere on the code editor and select Source | Override/Implement Methods...
	__3.  Scroll down in the list and check toString().  
	__4.  Click OK.
	__5.  Change the method to look like the following:
	__6.  Save the code.  There should be no problems.
	__7.  Go back to the BankAccountTester and run the code.  You should see the following:
	__8.  Close all.

	Part 5 -  Review

	Lab 20 -  Project - Improved Stock Output
	Part 1 -  Override Method
	__1.  Open the code of your Stock class if it is not already.
	__2.  Make sure the editor for the Stock class is active and select Source → Override/Implement Methods... from the RAD menus.
	__3.  Check off the toString method as shown below and click the OK button.
	__4.  Find the method that was added to the class.  Even though there may be a default implementation you would be free to change the implementation of the method and simply leave the signature as it is.

	Part 2 -  General Requirements
	Part 3 -  Sample Output
	Part 4 -  Tips
	Part 5 -  Discussion Questions

	Lab 21 -  Exception Handling
	Part 1 -  The Try-Catch Block
	__1.  Open SimpleAdder.java.  
	__2.  Run it and enter a String instead of a number.  What is returned?
	__3.  In SimpleAdder.java locate the line
	__4.  Delete it and replace it with the following code:
	__5.  Save and run the code.  
	__6.  Again, enter a String instead of a number. What do you see?

	Part 2 -  Creating Your Own Exception
	__1.  In the Package Explorer, right click on BankAccountProject and select New | Class.
	__2.  In the New Java Class wizard, set the Package to be com.simple.account
	__3.  Set the Name to be InsufficientFundsException
	__4.  Change the Superclass to be java.lang.Exception
	__5.  If it is checked, uncheck public static void main(String args[]).
	__6.  Check the box marked Constructors from superclass.
	__7.  Click Finish.
	__8.  Open BankAccount.java.
	__9.  Add the following method to the class:
	__10.  Save the code.  There should be no errors.
	__11.  Open BankAccountTester.java.  
	__12.  Add the following code at the end of the main method. 
	__13.  Save the file.  Look at the Problems view. What is happening? 
	__14.  Left click on the red X in the margin next to this line.  
	__15.  In the box that appears, double click Surround with try/catch. 
	__16.  Locate the line:
	__17.  Delete it.  In its place, enter:
	__18.  Save the file.  There should be no errors.

	Part 3 -  Run the Code and Trigger the Exception
	__1.  Let us see what this code now does. Run it.  
	__2.  Locate the line:
	__3.  Change it to:
	This should trigger a defect, which our code should catch. 
	__4.  Save and run the code.
	__5.  Close all open files.

	Part 4 -  Review

	Lab 22 -  Project - Better Error Handling
	Part 1 -  General Requirements
	Part 2 -  Sample Output
	Part 3 -  Tips
	Part 4 -  Discussion Questions

	Lab 23 -  Interfaces
	Part 1 -  Create the AccountManager Class
	__1.  Create a new class in the BankAccountProject and call the class AccountManager.  It should belong to the package com.simple.account.  It should not have a main method. 
	__2.  Add a field called account of type BankAccount as follows:
	__3.  Generate getter/setter methods for this field.
	__4.  Now, add the deposit/withdraw methods. 
	__5.  Save the code.  There should be no errors. 

	Part 2 -  Test the AccountManager
	__1.  In the BankAccountProject, create a class called AccountManagerTester that belongs to the package com.simple.test and it should have a main method. 
	__2.  Add the following code to the main method.  (Delete the //TODO comment) 
	__3.  Perform an “organize imports” (Ctrl-Shift-O).  
	__4.  Continue adding the following code:
	__5.  Add the following code to test this.
	__6.  Finally, let's add some output.
	__7.  Perform an “organize imports” (Ctrl-Shift-O).  
	__8.  Save and run the code. The output should be expected:

	Part 3 -  Changing The AccountManager
	__1.  Open the AccountManagerTester.java.  
	__2.  Locate the line:
	__3.  Change it to:
	__4.  Organize imports.  
	__5.  Save the code.  There should be no errors.  
	__6.  Run the code.  The output returns:

	Part 4 -  Create the BusinessAccount Class
	__1.  In the BankAccountProject, create a new class called BusinessAccount, belonging to package com.simple.account. Leave it as extending java.lang.Object and do not create a main method for it.
	__2.  Add the following fields:
	__3.  Generate getters/setters for these fields.  
	__4.  Create a constructor for this class.  The best way to do this is to right click anywhere on the code editor and select Source | Generate Constructor using Fields.  
	__5.  Click OK in the Generate Constructor using Fields window that appears.
	__6.  Add the toString method as follows:
	__7.  Add the deposit method as follows:
	__8.  Finally, add the withdraw methods as follows: (If you want, you can copy and paste it from the BankAccount class to save yourself some typing.)
	__9.  Save the code.  There should be no errors. 

	Part 5 -  Managing the BusinessAccount
	__1.  Open AccountManagerTester.java.  
	__2.  Locate the line:
	__3.  Change it to the following:
	__4.  Organize imports.  
	__5.  Save the code.  Look at the Problems view. There should be one error:

	Part 6 -  Examining Interfaces
	__1.  In the Package Explorer, right click on BankAccountProject and select New | Interface.  The New Java Interface window will appear.
	__2.  For the Package, enter com.simple.account
	__3.  For the Name, enter Account
	__4.  Click Finish.
	__5.  Add the following two method declaration to the interface.
	__6.  Save the code.  There should be no errors in this class. 
	Our contract is complete.  
	__7.  Open BankAccount.java and change the class declaration to the following:
	__8.  Save the code.  
	__9.  Now, open BusinessAccount.java.  As before, change the class declaration to the following:
	__10.  In the BusinessAccount.java file, locate the method deposit() and rename it to something else (like deposit2()). 
	__11.  Save the file.  If you then look at your Problems view, a new error appears.  
	__12.  Undo the change (i.e. rename the method back to deposit()) and save the file.  This error should go away.

	Part 7 -  Update the AccountManager
	__1.  Open AccountManager.java.
	__2.  Locate the field declaration:
	__3.  Change it to use the interface as follows:
	__4.  Now, locate the code for the getter method:
	__5.  Change its return type as follows:
	__6.  Finally, locate the code for the setter method:
	__7.  Change the parameter declaration as follows:
	__8.  Save the file.  
	__9.  Switch back to the AccountManagerTester.  There should be no errors here.  
	__10.  Run the code. You should get:
	__11.  Close all open files.

	Part 8 -  Review

	Lab 24 -  Collections
	Part 1 -  Revise the AccountManager
	__1.  Open AccountManager.java.  
	__2.  Locate the line 
	__3.  Delete it. In its place, add the following code.
	__4.  An error will appear because HashMap  has not been imported.  Perform an organize imports. 
	__5.  Delete the getAccount() and setAccount() methods.  They will not be used any more. 
	__6.  We now need a method to add an account to the HashMap.   Add the following method.
	__7.  There is still an error on this method. If you float the mouse cursor over the red X in the margin next to the line: 
	You will see a message stating that method getAccountID() is not understood.  Why is this happening?  Simple – the account that is passed into this method is actually an instance of the Account interface.  Recall that our interface only has 2 methods:  deposit and withdraw. Now, we are trying to call a method getAccountID() on it; this means we will have to add the getAccountID() method to the interface. 
	__8.  Click the red X in the margin you were just floating the mouse over.  A box appears.
	__9.  In the white box, double click the line Create method 'getAccountID' in type 'Account'
	__10.  A code editor will open on the Account interface.  Notice a new method has been added:
	__11.  Save the file. 
	__12.  Switch back to the AccountManager.java class.  Save the file.  There should now be no errors in the addAccount() method. Fortunately, the two implementors of the class (BankAccount and BusinessAccount) already have this getAccountID() method, so there is no need to actually add them. There will be some errors in the class that we will fix later.
	__13.  We now need to have a method that allows for the retrieval of an Account, based on a passed-in account ID parameter. Add the following method:
	__14.  Now we can tackle the deposit and withdraw methods.  Locate the two following methods:
	__15.  Delete the methods.
	__16.  Now, add the following two methods:
	__17.  Add the following method:
	__18.  Our code is done.  Save it.  There should be no errors.  

	Part 2 -  Test the New AccountManager
	__1.  Open AccountManagerTester.java.  
	__2.  Locate the main method and delete all the code inside it.  We will write new test code from scratch.
	__3.  In the now empty main method, add the following code.
	__4.  Organize imports.
	__5.  Add the following code:
	__6.  Now let us take a look at the contents of the AccountManager.  Add the following code:
	__7.  Save the code.  There should be no errors.  
	__8.  Run the code.  You should see some interesting results.
	__9.  In AccountManagerTester, delete the line:
	__10.  In its place, add the code:
	__11.  Add the following code:
	__12.  Save the code.  There should be no errors. 
	__13.  Run the code. 
	__14.  Close all open files.

	Part 3 -  Review

	Lab 25 -  Project - Multiple Stocks
	Part 1 -  Implementation Discussion
	Part 2 -  General Requirements
	Part 3 -  Sample Output
	Part 4 -  Tips
	Part 5 -  Discussion Questions

	Lab 26 -  Writing To A File
	Part 1 -  Serialization
	__1.  Open BusinessAccount.java.  
	__2.  Change the class declaration as follows:
	__3.  An error will appear. Organize imports.  
	__4.  Select java.io.Serializable and click Finish.
	__5.  Save the file.  There should be no errors.  
	__6.  Open BankAccount.java. 
	__7.  As before, change the class declaration as follows:
	__8.  Again, organize imports.  In the Organize Imports window, select java.io.Serializable and click Finish.
	__9.  Save the file.  There should be no errors.

	Part 2 -  Add the Write/Read Methods
	__1.  Open AccountManager.java. 
	__2.  Add the following method to the class.
	__3.  Add the following method to read data back in from the file.
	__4.  Organize imports and select the following imports: java.io.File, java.io.InputStream, and java.io.OutputStream.
	__5.  Save the file.  There should be no errors.

	Part 3 -  Test the Serialization
	__1.  Open AccountManagerTester.java.  
	__2.  Locate the line:
	__3.  Delete it.  In its place, add the following code:
	An error appears; this is happening because persist throws an IOException.  We have to catch it.  
	__4.  We will be lazy and let RAD generate a try/catch clause for us. Click on the red X in the margin next to the line.  In the pop-up box that appears, double click on Surround with try/catch.
	__5.  Save the code.  There should be no errors.  
	__6.   Run the code.  You should see nothing.  
	__7.  We have not printed anything to the console, so there will be no feedback here.  However, open a Windows file explorer and navigate to the C:\LsbFiles\ folder.  You should see a new file called users.dat.    This is our persisted AccountManager's collection!
	__8.  Open this file with a text editor (like Notepad).   It looks like a jumbled mess of binary and character data.  Believe it or not, that is our persisted HashMap!   Close the text editor. 
	__9.  Back in RAD, add the following code to the AccountManagerTester's main method. 
	__10.  There is an error on the call to load().  As with the persist() method, we have to handle potential exceptions.  Left click on the red X in the margin, and again select Surround with try/catch.
	__11.  Save the code.  There should be no errors. 
	__12.  Run the code.  You should see:
	__13.  Close all open files.

	Part 4 -  Review

	Lab 27 -  Project - Saving to a File
	Part 1 -  General Requirements
	Part 2 -  Sample Output
	Part 3 -  Tips
	Part 4 -  Discussion Questions




